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1. IMPORTANT NOTICE: DO NOT MODIFY THIS with FCC regulations does not guarantee that inter-

FCC INFORMATION (U.S.A.)

UNIT!
This product, when installed as indicated in the 
instructions contained in this manual, meets FCC 
requirements. Modifications not expressly approved 
by Yamaha may void your authority, granted by the 
FCC, to use the product.

2. IMPORTANT: When connecting this product to 
accessories and/or another product use only high 
quality shielded cables. Cable/s supplied with this 
product MUST be used. Follow all installation instruc-
tions. Failure to follow instructions could void your 
FCC authorization to use this product in the USA.

3. NOTE: This product has been tested and found to 
comply with the requirements listed in FCC Regula-
tions, Part 15 for Class “B” digital devices. Compli-
ance with these requirements provides a reasonable 
level of assurance that your use of this product in a 
residential environment will not result in harmful inter-
ference with other electronic devices. This equipment 
generates/uses radio frequencies and, if not installed 
and used according to the instructions found in the 
users manual, may cause interference harmful to the 
operation of other electronic devices. Compliance 
AUDIOGRAM 6 Owner’s Manual
ference will not occur in all installations. If this product 
is found to be the source of interference, which can 
be determined by turning the unit “OFF” and “ON”, 
please try to eliminate the problem by using one of 
the following measures:
Relocate either this product or the device that is 
being affected by the interference. 
Utilize power outlets that are on different branch (cir-
cuit breaker or fuse) circuits or install AC line filter/s.
In the case of radio or TV interference, relocate/reori-
ent the antenna. If the antenna lead-in is 300 ohm 
ribbon lead, change the lead-in to co-axial type cable.
If these corrective measures do not produce satisfac-
tory results, please contact the local retailer autho-
rized to distribute this type of product. If you can not 
locate the appropriate retailer, please contact 
Yamaha Corporation of America, Electronic Service 
Division, 6600 Orangethorpe Ave, Buena Park, 
CA90620
The above statements apply ONLY to those products 
distributed by Yamaha Corporation of America or its 
subsidiaries.
* This applies only to products distributed by YAMAHA CORPORATION OF AMERICA. (class B)
COMPLIANCE INFORMATION STATEMENT
(DECLARATION OF CONFORMITY PROCEDURE)

Responsible Party : Yamaha Corporation of America
Address : 6600 Orangethorpe Ave., Buena Park, Calif. 90620

Telephone : 714-522-9011
Type of Equipment : COMPUTER RECORDING SYSTEM

Model Name : AUDIOGRAM 6

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received including interference that may cause undesired operation.
See user manual instructions if interference to radio reception is suspected.
* This applies only to products distributed by YAMAHA CORPORATION OF AMERICA.
 (FCC DoC)
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PRECAUTIONS
PLEASE READ CAREFULLY BEFORE PROCEEDING 

* Please keep this manual in a safe place for future reference.

 WARNING
Always follow the basic precautions listed below to avoid the possibility of serious injury or even death from electrical 
shock, short-circuiting, damages, fire or other hazards. These precautions include, but are not limited to, the 
following:

• Do not open the device or attempt to disassemble the internal parts or 
modify them in any way. The device contains no user-serviceable 
parts. If it should appear to be malfunctioning, discontinue use 
immediately and have it inspected by qualified Yamaha service 
personnel.

• Do not expose the device to rain, use it near water or in damp or wet 
conditions, or place containers on it containing liquids which might 
spill into any openings. If any liquid such as water seeps into the 
device, unplug the USB cable from this device immediately. Then have 
the device inspected by qualified Yamaha service personnel.

• Never insert or remove a USB cable with wet hands.

 CAUTION
Always follow the basic precautions listed below to avoid the possibility of physical injury to you or others, or damage 
to the device or other property. These precautions include, but are not limited to, the following:

• Before moving the device, remove all connected cables.
• Avoid setting all volume controls to their maximum. Depending on the 

condition of the connected devices, doing so may cause feedback and 
may damage the speakers.

• Do not expose the device to excessive dust or vibrations, or extreme 
cold or heat (such as in direct sunlight, near a heater, or in a car during 
the day) to prevent the possibility of panel disfiguration or damage to 
the internal components.

• Do not place the device in an unstable position where it might 
accidentally fall over.

• Do not use the device in the vicinity of a TV, radio, stereo equipment, 
mobile phone, or other electric devices. Doing so may result in noise, 
both in the device itself and in the TV or radio next to it.

• Before connecting the device to other devices, turn off the power for all 
devices. Before turning the power on or off for all devices, set all 
volume levels to minimum.

• When turning on the AC power in your audio system, always turn on 
monitor speakers LAST, to avoid speaker damage. When turning the 
power off, monitor speakers should be turned off FIRST for the same 
reason.

• Do not insert your fingers or hands in any gaps or openings on the 
device.

• Avoid inserting or dropping foreign objects (paper, plastic, metal, etc.) 
into any gaps or openings on the device. If this happens, unplug the 
USB cable from the device immediately. Then have the device 
inspected by qualified Yamaha service personnel.

• Do not use the device or headphones for a long period of time at a high 
or uncomfortable volume level, since this can cause permanent 
hearing loss. If you experience any hearing loss or ringing in the ears, 
consult a physician.

• Do not rest your weight on the device or place heavy objects on it, and 
avoid use excessive force on the buttons, switches or connectors.

Do not open Water warning

Location

Connections

Handling caution

(5)-10 1/2
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Always unplug the USB cable from a computer or turn off the computer to turn off the device when the device is not in use.

The performance of components with moving contacts, such as switches, volume controls, and connectors, deteriorates over time. Consult 
qualified Yamaha service personnel about replacing defective components.

Specifications and descriptions in this owner’s manual are for information purposes only. Yamaha Corp. reserves the right to change or modify 
products or specifications at any time without prior notice. Since specifications, equipment or options may not be the same in every locale, please 
check with your Yamaha dealer.

SPECIAL NOTICES
• This manual is the exclusive copyright of Yamaha Corporation.

• The included software is the exclusive copyright of Steinberg Media Technologies GmbH.

• Use of the software and this manual is governed by the license agreement which the purchaser fully agrees to upon breaking the seal of the 
software packaging. (Please read carefully the Software Licensing Agreement at the end of this manual before installing the application.)

• Copying of the software or reproduction of this manual in whole or in part by any means is expressly forbidden without the written consent of the 
manufacturer.

• Yamaha makes no representations or warranties with regard to the use of the software and documentation and cannot be held responsible for the 
results of the use of this manual and the software.

• This disk containing the software is not meant for use with an audio/visual system (CD player, DVD player, etc.). Do not attempt to use the disk 
on equipment other than a computer.

• Future upgrades of application and system software and any changes in specifications and functions will be announced separately.  

• The screen displays as illustrated in this manual are for instructional purposes, and may appear somewhat different from the screens which 
appear on your computer. 

The illustrations and LCD screens as shown in this manual are for instructional purposes only, and may appear somewhat different from those on 
your instrument.

This product incorporates and bundles computer programs and contents in which Yamaha owns copyrights or with respect to which it has license 
to use others' copyrights.  Such copyrighted materials include, without limitation, all computer software, music data, etc. Any unauthorized use of 
such programs and contents outside of personal use is not permitted under relevant laws.  Any violation of copyright has legal consequences.  
DON'T MAKE, DISTRIBUTE OR USE ILLEGAL COPIES.

• Windows is a registered trademark of Microsoft® Corporation in the United States and other countries.

• Apple, Mac and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries.

• The company names and product names in this manual are the trademarks or registered trademarks of their respective companies.

MIC/INST jacks (XLR-type) are wired as follows (IEC60268 standard): pin 1: ground, pin 2: hot (+), and pin 3: cold (-).

Yamaha cannot be held responsible for damage caused by improper use or modifications to the device, or data that is lost or destroyed.

2 1

3

(5)-10 2/2
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Introduction
Thank you for choosing a Yamaha AUDIOGRAM 6 Computer Recording System. The AUDIOGRAM 6 
includes a USB audio interface for digital audio data transfer, and Cubase AI DAW (Digital Audio Worksta-
tion) software for Windows® and Macintosh® computer operating systems. With the AUDIOGRAM 6 and 
your personal computer you have the basic elements of a high-performance computer recording system that 
is easy to set up and operate.

Please read through this manual carefully before beginning use, so that you will be able to take full advan-
tage of your interface’s superlative features and enjoy trouble-free operation for years to come. After reading 
the manual, please store it in a safe place.
Introduction......................................... 5
Features.......................................................... 5
Contents ......................................................... 5
System Requirements .................................... 6

Setup.................................................... 7

Quick Guide......................................... 8
1. Installing Cubase AI.................................... 8
2. Connecting to the AUDIOGRAM 

interface ..................................................... 8
3. Powering Up the System ............................ 9
4. Adjusting Level ........................................... 9
5. Recording with Cubase AI ........................ 10
6. Mixing with Cubase AI .............................. 14

Controls and Functions ................... 15
Input Signal Flow .......................................... 16

Troubleshooting ............................... 17

Specifications ................................. 104
General Specifications................................ 104
Dimensional Diagrams................................ 104
Block Diagram and Level Diagram ............. 105

About the accessory disk .............. 106

SOFTWARE LICENSE 
AGREEMENT................................... 106
Connect To Your Computer via a Single 
USB Cable (page 8)
The AUDIOGRAM interface connects to your com-
puter via the supplied USB cable. Stereo audio data 
is transferred in both directions—from the interface 
to the computer, and vice-versa—via the USB con-
nection (44.1 kHz or 48 kHz sampling frequency).

No Driver Installation Required (page 8)
The AUDIOGRAM system uses the standard driv-
ers included in your computer’s operating system, 
so there’s no need to install any extra driver soft-
ware.

Cubase AI DAW Software Supplied (page 8)
Cubase AI software, included in the AUDIOGRAM 
package, offers versatile, high-performance hard-
disk recording capability.

Compression (page 16)
Compression increases the overall level without 
introducing distortion by compressing excessive 
peaks in the signals from microphones and guitars.

48V Phantom Power (page 16)
A PHANTOM switch supplies +48V phantom power 
to the channel 1 microphone input, so you can use 
high-quality phantom-powered condenser micro-
phones for superior recording quality.

Features

Accessories
• Cubase AI 4 DVD-ROM
• USB cable
• Owner’s Manual (this book)
Contents
5AUDIOGRAM 6 Owner’s Manual
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• Visit the web address below for the latest information on:
<http://www.yamahasynth.com/>

Computer System Requirements

Windows Vista

Windows XP

Macintosh

Cubase AI 4 System Requirements

Windows

Macintosh

• A DVD driver is required for installation.

• To activate your software license, install the
application while the computer is connected to
the internet.

System Requirements

NOTE

Computer Windows-based computer with built-in 
USB interface

OS Windows Vista

CPU 1 GHz or higher Intel Core/Pentium/
Celeron processor

Memory 1 GB or more

Computer Windows-based computer with built-in 
USB interface

OS Windows XP Professional/XP Home 
Edition

CPU 750 MHz or higher Intel Core/Pentium/
Celeron processor

Memory 96 MB or more (128 MB or more rec-
ommended)

Computer Macintosh computer with built-in USB 
interface

OS Mac OS X 10.3.3 or higher

CPU Macintosh G3 300 MHz or higher/Intel 
processor

Memory 128 MB or more

OS Windows XP Professional SP1 or 
higher/XP Home Edition SP1 or higher
Windows Vista (32 bit)

CPU 1.4 GHz or higher Intel Pentium pro-
cessor

Memory 512 MB or more

Audio Interface Windows DirectX/ASIO compatible

Hard Disk 1 GB or more

OS Mac OS X 10.4 or higher

CPU Power Mac G4 1 GHz/Core Solo 1.5 
GHz or higher

Memory 512 MB or more

Hard Disk 1 GB or more

NOTE
AUDIOGRAM 6 Owner’s Manual
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Setup
Microphone

Guitar

CD player

Keyboard, etc.

Computer

Headphones

Powered speakers

To connect a device such 
as a microphone:

To connect an instrument 
such as an electric guitar 
or bass:

USB cable

Cubase AI

Be sure to turn the PHANTOM 
+48V switch (★) on when 
using a phantom-powered 
condenser microphone.
7AUDIOGRAM 6 Owner’s Manual
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Quick Guide
8

   
This quick setup and operation guide covers everything from installing the Cubase AI software to using
Cubase AI for recording and mixdown. While going through this section you might find it useful to also
refer to the “Controls and Functions” section on page 15, as well as the pdf manual supplied with the
Cubase AI software.

Since the End-User Software License Agreement (EUSLA) shown on your PC-dis-
play in your installing the “DAW” software is replaced by the agreement at the end 
of this manual, you should disregard the EUSLA. Read the Software License Agree-
ment at the end of this manual carefully, and install the software if you agree to it.

1 Start the computer and log on to the Administrator account.

2 Insert the included DVD-ROM into the computer’s DVD-ROM drive.

3 Double-click on the “CubaseAI4.msi” icon in the “Cubase AI 4 for Windows” folder (for Windows 
users), or double-click the “CubaseAI4.mpkg” in the “Cubase AI 4 for MacOS X” (for Macintosh users).
Follow the on-screen instructions to install the Cubase AI software.

• In order to have continuous use of Cubase AI 4, including support and other benefits, you will 
need to register the software and activate your software license by starting it while the computer 
is connected to the Internet. Click the “Register Now” button shown when the software is started, 
then fill in all required fields for registration. If you do not register the product, you will be unable 
to use the application after a limited period of time expires.

1 Turn all gear that is to be connected to the 
AUDIOGRAM off or to standby mode (except 
the computer), and set the LEVEL controls, 
MASTER LEVEL control and DAW control to 
their minimum settings.

2 Connect microphones and/or instruments.
For details on making connections refer to the 
“Setup” section on page 7 and the “Controls and 
Functions” section on page 15.

3 Set the MIC/INST switch according to the 
type of device connected to channel 1 or 2.
Select MIC ( ) if a microphone is connected, or 
INST ( ) if a guitar or similar instrument is con-
nected.

4 To use channels 1 and 2 as independent mono 
channels set the MONO/STEREO switch to 
MONO ( ). To use channels 1 and 2 as a ste- 
reo pair set the switch to STEREO ( ).

 

Step

 

1

 

Installing Cubase AI

Step 2 Connecting to the AUDIOGRAM interface

IMPORTANT !

NOTE

LEVEL controls MASTER LEVEL control

DAW 
control

Be sure to turn the   
PHANTOM +48V switch 
on when using a phantom-
powered condenser 
microphone.
AUDIOGRAM 6 Owner’s Manual
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To prevent loud pops and noises, turn on the power 
to your sound gear starting with the sources 
(instruments, CD players, etc.) and ending with the 
monitor speakers (powered speakers).

1 Turn on the instruments and microphones.

2 If you are using a condenser microphone for 
the channel 1, turn on the PHANTOM +48V 
switch.

Observe the following precautions when 
turning on phantom power.

• Make sure that the PHANTOM +48V switch 
is off when phantom power is not needed.

• When turning the switch on, be sure that 
only a condenser microphone is con-
nected to the channel 1 MIC/INST input 
jack. Other devices may be damaged if 
connected to phantom power. This precau-
tion does not apply to balanced dynamic 
microphones or instruments with the 
phone jack, however, as these will not be 
affected by phantom power.

• To prevent damage to speakers, be sure to 
turn off power amplifiers (or powered 
speakers) before turning this switch on or 
off. We also recommend that you set the 
MASTER LEVEL control to the minimum 
position before operating this switch to 
avoid the risk of loud noises that could 
cause hearing loss or device damage.

3 Connect the AUDIOGRAM interface to your 
computer using the supplied USB cable.
The POWER indicator will light to indicate that power 
is being applied to the AUDIOGRAM interface.

When connecting or disconnecting the USB 
cable be sure to turn the DAW control and the 
MASTER LEVEL control all the way down.

The first time you connect to the computer’s
USB connector, or change the connection to
a different USB port, a driver installation dis-
play may appear. If this occurs, wait until the
installation is complete before proceeding.

4 Turn the power to the monitor speakers 
(powered-speakers).

1 Set the GAIN controls to the minimum position 
and the LEVEL controls to about 1 o’clock.

Set the MASTER LEVEL control to the mini-
mum position. Failure to do so may result in 
loud noise bursts that can damage your 
equipment, your ears, or both.

2 Adjust the volume on all instruments that are 
connected to the AUDIOGRAM interface.

3 Adjust the channel GAIN controls so that the 
corresponding PEAK indicators flash briefly 
on the highest peak levels.

4 Adjust the overall volume with the MASTER 
LEVEL control while monitoring via head-
phones or monitor speakers.
Lower the volume using the LEVEL controls until the 
level indicator PEAK LEDs flash only briefly on occa-
sional high-level peaks or not at all.

Step 3 Powering Up the System

CAUTION

USB Connection Precautions
Be sure to observe the following points when connect-
ing to the computer's USB interface.
Failure to observe these rules can result in computer 
freezes/hang-ups and possibly data loss or corruption. 
If the instrument or computer does hang up, restart the 
application or computer.

• Be sure to wake the computer from sleep/
suspended/standby mode before making a
connection to the computer’s USB connec-
tor.

• Always quit all applications running on the
computer before connecting or disconnect-
ing the USB cable.

• Wait at least 6 seconds between connecting
or disconnecting the USB cable.

CAUTION

CAUTION

NOTE

Step 4 Adjusting Level

CAUTION

GAIN controls

LEVEL controls

PEAK indicators MASTER LEVEL control

DAW control

Level indicator
9AUDIOGRAM 6 Owner’s Manual
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This section describes the procedure for recording to the Cubase AI software we installed earlier via the 
AUDIOGRAM interface.

For details on operation of the Cubase AI software refer to the pdf-format manual provided with the
software.

Cubase AI Setup

1 Set the computer output to the maximum 
level.
For details on how to make the setting refer to the 
“The recorded sound is too low in level.” section in 
the “Troubleshooting” on page 17.

2 Launch Cubase AI.

Windows:
Click [Start] → [All Program] → [Steinberg Cubase 
AI 4] → [Cubase AI 4] to launch the program. If the 
ASIO Multimedia dialog window appears, click 
[Yes].

Macintosh:
Double-click the [Application] → [Cubase AI 4].

• If you specified a file destination when 
installing the Cubase AI software, launch the 
application from that location.

• Create a Cubase AI shortcut or alias on your 
desktop so you can easily launch the pro-
gram when required.

3 Select [Device Setup] from the [Device] 
menu to open the Device Setup window.

Windows:
Select [VST Audio System] in the [Device] field on 
the left side of the window. Select [ASIO DirectX 
Full Duplex Driver] in the [ASIO Driver] field on the 
right side of the window. A dialog box will appear 
asking “Do you want to switch the ASIO driver?”. 
Click [Switch].

Macintosh:
Select [VST Audio System] in the [Device] field on 
the left side of the window. Select [USB Audio 
CODEC (2)] in the [ASIO Driver] field on the right 
side of the window, and click [OK]. Skip ahead to 
step 7, below.

Under Mac OS X you can select either [USB 
Audio CODEC (1)] or [USB Audio CODEC (2)] 
in the [ASIO Driver] field. Normally you should 
select [USB Audio CODEC (2)], but if you will 
only be playing back and mixing previously 
recorded data you can select [USB Audio 
CODEC (1)] to lighten the load on the com-
puter’s CPU.

Step 5 Recording with Cubase AI

NOTE

NOTE

NOTE
AUDIOGRAM 6 Owner’s Manual
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4 On a Windows computer select [ASIO 
DirectX Full Duplex Driver] in the [Devices] 
field on the left side of the Device Setup win-
dow, and click [Control Panel] on the right 
side of the window.

5 The ASIO Direct Sound Full Duplex Setup 
dialog box will be displayed. Check only the 
input port and output port [USB Audio 
CODEC] checkbox.

6 Make sure that “USB Audio CODEC 1/2” are 
shown in the [Port System Name] field, and 
check the [Visible] column in the Device Setup 
window. Click [OK] to close the window.

• If the [Port System Name] field does not 
change, close and restart the Cubase AI, 
then open the Device Setup window.

• The input ports may not be shown if you are 
using Windows Vista. If so, refer to the “The 
input ports are not shown” section in the 
Troubleshooting section (page 17).

7 Select [New Project] from the [File] menu to 
create a new project file.
The new project dialog window will open. For this 
example select [CAI4 - 4 Stereo 8 Mono Audio Track 
Recorder] and click [OK].

Recorded Cubase AI data is stored as a 
“project file”.

8 When the directory selection dialog window 
appears, select the folder to which the 
project and audio files for the project are to 
be stored, and click [OK].
An empty project window with 4 stereo and 8 mon-
aural tracks will appear.

NOTE

NOTE

Project window

Transport panel

Mixer window
11AUDIOGRAM 6 Owner’s Manual
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Preparing to Record

1 Click in the track list (the area in which the 
track names are displayed) to select a track 
to record on.
The various settings for the selected track are avail-
able in the Inspector on the left side of the display.

You will normally use a stereo track when 
recording synthesizers, and a monaural track 
when recording vocals or guitars.

2 Click the Input Routing field in the Inspector 
to select the audio input source. Select “Ste-
reo In 1” for a stereo track and “Left (Right)-
Stereo In 1” for a monaural track.

3 Make sure the [Record Enable] button for the 
track to be recorded is turned on.
If the [Record Enable] button is off, click it to turn it 
on.

4 Play the instrument to be recorded, and 
adjust the AUDIOGRAM GAIN controls and 
LEVEL controls so that the Clipping indica-
tor never lights.

5 Specify the point at which you want to start 
recording via the ruler at the top of the 
project window.
Click the black area of the ruler to move the project 
cursor (the vertical black line) to that position.

Inspector

Input routing

[Record Enable] button Track list

NOTE

<Transport panel>
Clipping indicator

Ruler
AUDIOGRAM 6 Owner’s Manual
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Recording and Playback

1 Click the Transport panel [Record] button to 
begin recording.
When recording is started the project cursor will 
begin moving to the right and a box that displays the 
recording results will be created.

2 Play the part.

3 When you finish recording the track, click 
the Transport panel [Stop] button.

4 To hear playback of the track you have just 
recorded, use either the Transport panel 
[Rewind] button or the ruler to rewind to the 
beginning of the recorded section, then click 
the Transport panel [Start] button.
The overall playback level will be displayed via the 
master section bus level meter on the right side of the 
mixer window, and the channel level will be dis-
played via the channel strip level meter.

• Click the [Narrow/Wide] button in the upper 
left corner of the mixer window to increase 
the width of the mixer’s channel strips.

• To hear the playback sound via the AUDIO-
GRAM interface, adjust the volume with the 
DAW control and MASTER LEVEL control.
The playback level will approximately match 
the recording level when the DAW control is 
set to about 1 o’clock.

5 To save the project file select [Save] from the 
[File] menu and enter a file name before actu-
ally saving the file.
Save your project file frequently to insure against los-
ing large amounts of data if a problem occurs.

6 Repeat steps 1 through 5 to record further 
material on the same track.

7 To record additional material on a different 
track, select a new track and repeat the 
record procedure.

Recording with maximum quality and mini-
mum noise:
For optimum sound quality with minimum noise, the 
AUDIOGRAM signal levels should be set as high as 
possible without clipping. Check signal levels to be 
sent to Cubase AI for recording using the AUDIO-
GRAM level indicators while the DAW control is set to 
minimum. Adjust the channel LEVEL controls so that 
the corresponding PEAK LEDs flash only occasionally 
on the highest input transients.

Stop

Record

Start

Rewind

Forward

<Transport panel>

Recording results

NOTE

Level meter

[Narrow/Wide] button[Narrow/Wide] button

Bus level mete
13AUDIOGRAM 6 Owner’s Manual
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In this section we’ll try mixing down multiple recorded audio tracks to stereo, and creating a wav file. Mixes 
can be stored as WAV or AIFF files, which can then be recorded to audio CDs.

1 Launch Cubase AI and open a project file.

2 Click the [Start] button on the Transport 
Panel.

3 While listening to playback, drag the channel 
strip level faders up and down to create the 
desired initial balance, then adjust the over-
all volume using the bus volume fader.

4 Drag the pan controls on the top of the 
channel strips left and right to set the ste-
reo position of each track.

5 At this point you can begin to use EQ to 
refine your mix, and add effects.
As an example let’s try adding reverb. Click the 
[Edit] button ( ) on the left side of the channel 
strip to open the VST audio channel settings window. 
Click Insert 1 and select Reverb - RoomWorks SE.

For further details refer to the pdf manual pro-
vided with the Cubase AI software.

It’s a good idea to lower the channel fader a 
bit before adding an effect, since the effect 
can cause an increase in the overall channel 
level.

6 When the final mix adjustments have 
been made, go to the [File] menu and 
select [Export] → [Audio Mixdown].

7 Enter a file name and select a destination 
for the file as well as a file type.
If you intend to use the file to create an audio CD, 
select the WAV file type (AIFF on Macintosh OS X), 
Stereo Out (stereo), 44.1 kHz, and 16 bit.

8 Click [Export].
Progress of the mixdown operation will be shown in 
a progress window. When the progress window 
closes the mixdown is complete.

Files created by mixdown can be directly 
played back using the Windows Media 
Player, or iTunes.

Step 6 Mixing with Cubase AI

NOTE

CAUTION

NOTE
AUDIOGRAM 6 Owner’s Manual
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Controls and Functions
1 MIC/INST Input Jack
Microphones and instruments such as guitars can be
connected here using XLR or phone jack cables. Set
the MIC/INST switch 5 to MIC or INST according to
the type of device connected.

You can directly connect an electric guitar or 
bass without the need for a separate DI 
(Direct Injection) box or amp simulator.

2 LINE Input Jacks (L (MONO)/R)
These inputs are intended mainly for use with instru-
ments and equipment having stereo outputs, such as a
synthesizer or CD player.
If you connect to the L (MONO) jack only, the AUDIO-
GRAM will recognize the signal as monaural and will
send the identical signal to both the L and R jacks.

3 STEREO OUT Jacks
These output the mixed signal from channels 1 to 5/6.
The output level can be adjusted using the MASTER
LEVEL control. These jacks would typically be con-
nected to monitor speakers (powered speakers).

4 PHONES Jack
Connects a pair of headphones to this jack. The
PHONES jack outputs the same signal as the STEREO
OUT jacks.

5 MIC/INST Switch
Set this switch according to the type of device con-
nected. Select MIC ( ) if a microphone is connected,
or INST ( ) if an electric guitar or bass is connected.

If a device is not connected to the MIC/
INST jack, set this switch to MIC ( ). 
Otherwise noise may occur.

6 GAIN Control
Adjusts the input signal level. To achieve the best bal-
ance between S/N ratio and dynamic range, adjust the
level so that the input channel PEAK indicator 9 lights
only occasionally and briefly on the highest input tran-
sients.

!6

q w e

t

!1

!2

!3

!4

!5

o

!0

u
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XLR-type Phone-type

NOTE

Phone-type

NOTE
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7 COMP Control
Adjusts the amount of compression applied to the chan-
nel. As the knob is turned to the right, the interface
automatically raises the compression ratio while adjust-
ing the output gain accordingly. The result is smoother,
more even dynamics because louder signals are atten-
uated while the overall level is boosted.

Avoid setting the compression too high, as 
the higher average output level that results 
may lead to feedback.

8 MONO/STEREO Switch
This switch allows channels 1 and 2 to be used either
as separate mono channels or as a stereo pair. When
set to MONO ( ), channels 1 and 2 function as inde-
pendent mono channels feeding both the L and R STE-
REO OUT jacks 3. When set to STEREO ( ), input
channels 1 and 2 function as a stereo pair: the channel
1 signal feeds the L STEREO OUT jack and the chan-
nel 2 signal feeds the R STEREO OUT jack. 

9 PEAK Indicators
The PEAK indicators light when the channel signal
reaches or exceeds clipping level. Note that signal lev-
els as indicated by the PEAK indicators are affected by
both the GAIN and LEVEL controls.
If a PEAK indicator lights, adjust the GAIN 6 and
COMP 7 controls to lower the level so that the indica-
tor goes out.

0 LEVEL Controls
Adjusts the level of the channel signal. Use these con-
trols to adjust the balance between the various chan-
nels.

A POWER Indicator
This indicator lights when power is applied to the
AUDIOGRAM interface via the USB cable (supplied)
that connects it to the computer.

B PHANTOM +48V (CH1) Switch/Indicator 
(only for channel 1)
This switch toggles phantom power on and off. If you
set the switch on ( ), the AUDIOGRAM supplies
phantom power to channel 1 MIC/INST jack (XLR-type)
1. Turn this switch on when using a phantom-powered
condenser microphone.

• Be sure to leave this switch off ( ) if 
you do not need phantom power.

• When turning the switch on, be sure that 
only a condenser microphone is con-
nected to the channel 1 MIC/INST input 
jack. Other devices may be damaged if 
connected to phantom power. This precau-
tion does not apply to balanced dynamic 
microphones or instruments with the 
phone jack, however, as these will not be 
affected by phantom power.

• To prevent damage to speakers, be sure to 
turn off power amplifiers (or powered 
speakers) before turning this switch on or 
off. We also recommend that you set the 
MASTER LEVEL control to the minimum 
position. Neglect of these precautions may 
result in large noise bursts that may dam-
age your equipment, your ears, or both.

C Level Indicators
These indicators show signal levels prior to the MASTER
LEVEL control E. The SIGNAL LED lights when a signal
is present, and the PEAK LED lights when the signal
reaches or exceeds clipping level.  Adjust the input chan-
nel LEVEL controls 0 so that the PEAK LEDs flash only
briefly on occasional high-level peaks or not at all.

D DAW Control
Adjusts the level of the signal received from Cubase AI
sent to the AUDIOGRAM STEREO OUT jacks 3.

E MASTER LEVEL Control
Adjusts the signal level sent to the STEREO OUT jacks
3. This allows you to adjust the overall volume without
changing the relative volume balance among the chan-
nels.

F USB Connector
Connects the AUDIOGRAM interface to a USB port on
your computer via the supplied USB cable. In addition
to transferring audio data between the AUDIOGRAM
interface and the computer, the USB cable supplies
power from the computer to the AUDIOGRAM interface.

When connecting or disconnecting the USB 
cable be sure to turn the DAW control and the 
MASTER LEVEL control all the way down.

Yamaha recommends that you use a USB 
cable with a length of 1.5 meter or less.

■ Input Signal Flow

NOTE

CAUTION

CAUTION

NOTE

Input
Output

Adjust for maxi-
mum level with 
minimum noise.

Compress the sig-
nal for increased 
subjective level.

Adjust the recording level 
as well as the balance 
between channels.

Adjusts the 
monitor level.

Adjusts the playback 
level from Cubase AI 
(does not affect the 
record level).

Record Playback

E MASTER 
LEVEL controlD DAW 

control

0 LEVEL 
controls

7 COMP 
controls

6 GAIN 
controls

C Level
indicator

Cubase AI
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Troubleshooting
The AUDIOGRAM interface won’t turn on.
❑ Is the included USB cable properly plugged into the

interface and a computer?

The system doesn’t work properly.
❑ Are the USB cable and all necessary audio cables

properly connected?

❑ Are you using a USB hub?
USB hubs can interfere with proper operation, so try
connecting the AUDIOGRAM interface directly to a
USB port on the computer. If the computer has multi-
ple USB ports, try a different USB port.

❑ Are you using other USB devices at the same time?
If so, try removing the other device(s) and connecting
only the Yamaha USB device.

The Input ports are not shown (Windows Vista)
❑ Is the sound input of your computer operating system

assigned properly?

1. From the [START] menu click [Control Panel],
then double-click the “Sound” icon to open the
“Sound” dialog window.

2. Click the “Recording” tab, right-click the “USB
Audio CODEC" icon and select “Properties.”

3. Click the “Advanced” tab, then select “2 channel, 16
bit, 44100 Hz (CD Quality)” or “2 channel, 16 bit,
48000 Hz (DVD Quality)” in the “Default Format”
field.

No sound.
❑ Are your speaker cables connected properly, or are

they shorted?

❑ Are the volume controls of your sources, audio
devices, applications software, computer operating
system, etc., set at appropriate levels?

❑ Is the output of your computer operating system
muted?

❑ Do you have several applications running at the
same time?
Be sure to quit all applications you are not using.

❑ Is the sound output of your computer operating sys-
tem assigned properly?

Windows Vista:

1. From the [START] menu click [Control Panel],
then double-click the “Sound” icon to open the
“Sound” dialog window.

2. Click the “Playback” tab and check whether the
“USB Audio CODEC” icon is checked.
If not, right-click the “USB Audio CODEC” icon and
select “Set as Default Device.”

3. Click the [Recording] tab and check whether the
“USB Audio CODEC” icon is checked.
If not, right-click the “USB Audio CODEC" icon and
select “Set as Default Device.” 

Windows XP:

1. From the [START] menu click [Control Panel],
then double-click the “Sounds and Audio Devices”
icon to open the “Sounds and Audio Devices Prop-
erties” dialog window.

2. Click the “Audio” tab.

3. Set “Sound playback: Default device” and “Sound
recording: Default device” to “USB Audio CODEC.”

4. Click [OK].

Macintosh:

1. Select “System Preferences ...” from the Apple
menu and then select “Sound” to open the “Sound”
dialog window.

2. Click the “Input” tab and under “Choose a device
for sound input” select “USB Audio CODEC”.

3. Click the “Output” tab and under “Choose a device
for sound output” select “USB Audio CODEC”.

❑ Is the sound output of the Cubase AI application
assigned properly?
For setup details refer to page 8 of the Quick Guide.

The recorded sound is too low in level.
❑ Is the computer’s output level setting too low?

We recommend that you set the computer output to
the maximum level and mute the computer’s internal
speaker.

Windows Vista:

1. From the [START] menu click [Control Panel],
then double-click the “Sound” icon to open the
“Sound” dialog window.

2. Click the “Playback” tab, right-click the “USB Audio
CODEC” icon and select “Properties”.

3. Click the “Levels” tab, then set the volume slider to
its maximum level.
Close the “Properties” dialog window.

4. Click the “Sounds” tab in the “Sound” dialog win-
dow, then select “No sounds” in the “Sound
Scheme.”

Windows XP:

1. From the [START] menu click [Control Panel],
then double-click the “Sounds and Audio Devices”
icon to open the “Sounds and Audio Devices Prop-
erties” dialog window.

2. Click the “Volume” tab.

3. Set “Device volume” to “High.”

4. Click the “Sound” tab.

5. Select “No sound” in the “Sound scheme.”
17AUDIOGRAM 6 Owner’s Manual
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Macintosh:

1. Select [System Preferences ...] from the Apple
menu and then select “Sound” to open the “Sound”
dialog window.

2. Click the “Output” tab and set the volume slider at
the bottom of the window to its maximum level.

3. Click the “Sound Effect” tab and set the volume
slider of the “Alert volume” slider to its minimum
level.

❑ Have you connected or disconnected the USB cable
while Cubase AI is running?
Doing so can sometimes cause the Windows output
level to be reset to its default level. Check and raise
the output level if necessary.

The sound is intermittent or distorted.
❑ Is the PEAK indicator flashing red?

You might have to lower GAIN or LEVEL control lev-
els to avoid distortion.

❑ Are you applying the compressor at an appropriate
level?
You might have to lower  COMP control levels.

❑ Does the computer you are using meet the listed
system requirements?
Refer to “Computer System Requirements” on page
6  for details.

❑ Are any other applications, device drivers, or USB
devices (scanners, printers, etc.) running at the
same time?
Be sure to quit all applications you are not using.

❑ Are you playing back a large number of audio
tracks?
The number of tracks you can play at the same time
will depend on the performance of the computer you
are using. You may experience intermittent playback
if you exceed your computer’s capabilities.

❑ Are you recording or playing long continuous sec-
tions of audio?
The audio data processing capabilities of your com-
puter will depend on a number of factors including
CPU speed and access to external devices.

On Windows XP computers, changing some settings
as outlined below can improve performance.

1. Click [Control Panel] from the [START] menu, and
double-click the “Sounds and Audio Devices” icon
to open the “Sounds and Audio Devices Proper-
ties” dialog window.

2. Click the “Volume” tab and click “Advanced” in
“Speaker settings.” The “Advanced Audio Proper-
ties” dialog window will open.

3. Click the “Performance” tab. Set “Hardware accel-
eration” to “Full”, and “Sample rate conversion
quality” to “Good.”

Don’t change these settings if you are not familiar
with your computer’s operating system.

Check that the file system is set properly, and make
sure that you have a plenty of free memory (more
than 128 megabytes). If the wave files you are
recording or playing are not too large, changing the
virtual memory settings can sometimes improve
audio performance.

In some cases it might be necessary to update your
hard disk controller, device drivers, or BIOS. Refer to
your computer’s support center or support page on
the web for more information.

❑ Try adding memory.
Adding more RAM memory can significantly increase
your computer’s audio performance. Refer to your
computer’s owner’s manual for information on install-
ing and setting up extra memory.

There is a delay when playing a software synthe-
sizer via a MIDI keyboard (latency).
❑ Check the URL listed below for the latest information.

<http://www.yamahasynth.com/>
AUDIOGRAM 6 Owner’s Manual
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Specifications
■ General Specifications

■ Dimensional Diagrams

Jacks MIC/INST Input Jack x 2 Combo jacks (Mic/HiZ)

LINE Input Jacks (L, R) x 2 Phone jacks

PHONES Jack x 1 Phone jack

STEREO OUT Jacks (L, R) x 1 Phone jacks

USB Connector x 1 USB 1.1 44.1/48 kHz, 16 bit

Controls MIC/INST Switch x 2 MIC: for microphones
INST (Hi-Z): for guitars, etc.

GAIN Control x 4 Gain for CH 1-5/6

COMP Control x 2 Compressor for CH 1, 2

MONO/STEREO Switch x 1 MONO: CH 1, 2 signals fuction as independent mono channels.
STEREO: CH 1, 2 signals fuction as a stereo pair.

LEVEL Control x 4 Adjust the level of CH 1-5/6

PHANTOM +48V Switch x 1 48 V, only for CH1

DAW Control x 1 Adjusts the DAW playback signal

MASTER LEVEL Control x 1 Adjusts the overall signal

Indicators Level Indicators x 1 2 points (green, red)

PEAK Indicator x 4 Red

Phantom Power x 1 Red

Power x 1 Green

Power Supply USB bus-powered

Dimensions (W x H x D) 170 x 59 x 192 mm

Net Weight 760 g

Included Accessories Cubase AI 4 DVD-ROM
USB cable
Owner’s Manual

56
51

W: 170

D: 192

3

H: 59

38

Unit: mm
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■ Block Diagram and Level Diagram
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About the accessory disk
SPECIAL NOTICE
• The software included in the accessory disk and 

the copyrights thereof are under exclusive owner-
ship by Steinberg Media Technologies GmbH.

• Use of the software and this manual is governed by 
the license agreement which the purchaser fully 
agrees to upon breaking the seal of the software 
packaging. (Please read carefully the Software 
Licensing Agreement at the end of this manual 
before installing the application.)

• Copying of the software or reproduction of this 
manual in whole or in part by any means is 
expressly forbidden without the written consent of 
the manufacturer.

• Yamaha makes no representations or warranties 
with regard to the use of the software and docu-
mentation and cannot be held responsible for the 
results of the use of this manual and the software.

• This disk is NOT for audio/visual purpose. Do not 
attempt to play the disk on an audio/visual CD/DVD 
player. Doing so may result in irreparable damage 
to your player.

• For information about the minimum system require-
ments and latest information of the software in the 
disk, check the web site below.
<http://www.yamahasynth.com/>

• Note that Yamaha does not offer technical support 
for the DAW software in the accessory disk.

About the DAW software in the 
accessory disk
The accessory disk contains DAW software both for 
Windows and Macintosh.

• Make sure to install DAW software under the
“Administrator” account.

• In order to have continuous use of the DAW software
in the accessory disk, including support and other
benefits, you will need to register the software and
activate your software license by starting it while the
computer is connected to the Internet. Click the
“Register Now” button shown when the software is
started, then fill in all required fields for registration.
If you do not register the software, you will be unable
to use it after a limited period of time expires.

• If you are using a Macintosh computer, double-click
the “***.mpkg” file to start installation.

For information about the minimum system require-
ments and latest information on the software in the 
disk, check the web site below.
<http://www.yamahasynth.com/>

About software support
Support for the DAW software in the accessory disk 
is provided by Steinberg on its website at the follow-
ing address.
http://www.steinberg.net

You can visit the Steinberg site also via the Help 
menu of the included DAW software. (The Help menu 
also includes the PDF manual and other information 
on the software.)

ATTENTION

SOFTWARE LICENSE AGREEMENT
PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“AGREEMENT”) CAREFULLY BEFORE USING THIS SOFT-
WARE. YOU ARE ONLY PERMITTED TO USE THIS SOFTWARE PURSUANT TO THE TERMS AND CONDITIONS OF 
THIS AGREEMENT. THIS AGREEMENT IS BETWEEN YOU (AS AN INDIVIDUAL OR LEGAL ENTITY) AND YAMAHA 
CORPORATION (“YAMAHA”).

BY BREAKING THE SEAL OF THIS PACKAGE YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. 
IF YOU DO NOT AGREE WITH THE TERMS, DO NOT INSTALL, COPY, OR OTHERWISE USE THIS SOFTWARE.

THIS AGREEMENT PROVIDES YOUR USE-CONDITIONS ABOUT THE “DAW” SOFTWARE OF STEINBERG MEDIA 
TECHNOLOGIES GMBH(“STEINBERG”) WHICH IS BUNDLED WITH THIS PRODUCT. SINCE THE END-USER SOFT-
WARE LICENSE AGREEMENT (EUSLA) SHOWN ON YOUR PC-DISPLAY IN YOUR INSTALLING THE “DAW” SOFT-
WARE IS REPLACED BY THIS AGREEMENT, YOU SHOULD DISREGARD THE EUSLA. THAT IS, IN THE INSTALLING 
PROCESS, YOU SHOULD SELECT “AGREE” WITH THE EUSLA, WITHOUT YOUR JUDGMENT THERETO, SO AS TO 
PROCEED TO THE NEXT PAGE.

1. GRANT OF LICENSE AND COPYRIGHT
Yamaha hereby grants you the right to use one copy of 
the software program(s) and data (“SOFTWARE”) 
accompanying this Agreement. The term SOFTWARE 
shall encompass any updates to the accompanying 
software and data. The SOFTWARE is owned by STEIN-
BERG, and is protected by relevant copyright laws and 
all applicable treaty provisions. Yamaha has acquired 
the sublicense right to license you to use the SOFT-
WARE. While you are entitled to claim ownership of the 
data created with the use of SOFTWARE, the SOFT-
WARE will continue to be protected under relevant copy-
rights.

• You may use the SOFTWARE on a single com-
puter.

• You may make one copy of the SOFTWARE in 
machine-readable form for backup purposes only, 
if the SOFTWARE is on media where such backup 
copy is permitted. On the backup copy, you must 
reproduce Yamaha’s copyright notice and any 
other proprietary legends that were on the original 
copy of the SOFTWARE.

• You may permanently transfer to a third party all 
your rights in the SOFTWARE only when you trans-
fer this product together, provided that you do not 
retain any copies and the recipient reads and 
agrees to the terms of this Agreement.

NOTE
6 AUDIOGRAM 6 Owner’s Manual
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2. RESTRICTIONS
• You may not engage in reverse engineering, dis-

assembly, decompilation or otherwise deriving a 
source code form of the SOFTWARE by any 
method whatsoever.

• You may not reproduce, modify, change, rent, 
lease, or distribute the SOFTWARE in whole or in 
part, or create derivative works of the SOFTWARE.

• You may not electronically transmit the SOFT-
WARE from one computer to another or share the 
SOFTWARE in a network with other computers.

• You may not use the SOFTWARE to distribute ille-
gal data or data that violates public policy.

• You may not initiate services based on the use of 
the SOFTWARE without permission by Yamaha 
Corporation.

Copyrighted data, including but not limited to MIDI data 
for songs, obtained by means of the SOFTWARE, are 
subject to the following restrictions which you must 
observe.
• Data received by means of the SOFTWARE may 

not be used for any commercial purposes without 
permission of the copyright owner.

• Data received by means of the SOFTWARE may 
not be duplicated, transferred, or distributed, or 
played back or performed for listeners in public 
without permission of the copyright owner.

• The encryption of data received by means of the 
SOFTWARE may not be removed nor may the elec-
tronic watermark be modified without permission of 
the copyright owner.

3. TERMINATION
This Agreement becomes effective on the day that you 
receive the SOFTWARE and remains effective until ter-
minated. If any copyright law or provisions of this Agree-
ment is violated, the Agreement shall terminate 
automatically and immediately without notice from 
Yamaha. Upon such termination, you must immediately 
destroy the licensed SOFTWARE, any accompanying 
written documents and all copies thereof.

4. LIMITED WARRANTY ON MEDIA
As to SOFTWARE sold on tangible media, Yamaha war-
rants that the tangible media on which the SOFTWARE is 
recorded will be free from defects in materials and work-
manship under normal use for a period of fourteen (14) 
days from the date of receipt, as evidenced by a copy of 
the receipt. Yamaha’s entire liability and your exclusive 
remedy will be replacement of the defective media if it is 
returned to Yamaha or an authorized Yamaha dealer 
within fourteen days with a copy of the receipt. Yamaha 
is not responsible for replacing media damaged by 
accident, abuse or misapplication. TO THE FULLEST 
EXTENT PERMITTED BY LAW, YAMAHA EXPRESSLY 
DISCLAIMS ANY IMPLIED WARRANTIES ON THE TAN-
GIBLE MEDIA, INCLUDING THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICU-
LAR PURPOSE.

5. DISCLAIMER OF WARRANTY ON 
SOFTWARE

You expressly acknowledge and agree that use of the 
SOFTWARE is at your sole risk. The SOFTWARE and 
related documentation are provided “AS IS” and without 
warranty of any kind. NOTWITHSTANDING ANY OTHER 
PROVISION OF THIS AGREEMENT, YAMAHA 
EXPRESSLY DISCLAIMS ALL WARRANTIES AS TO THE 
SOFTWARE, EXPRESS, AND IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NON-INFRINGEMENT OF THIRD 
PARTY RIGHTS. SPECIFICALLY, BUT WITHOUT LIMIT-
ING THE FOREGOING, YAMAHA DOES NOT WARRANT 
THAT THE SOFTWARE WILL MEET YOUR REQUIRE-
MENTS, THAT THE OPERATION OF THE SOFTWARE 
WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT 
DEFECTS IN THE SOFTWARE WILL BE CORRECTED.

6. LIMITATION OF LIABILITY
YAMAHA’S ENTIRE OBLIGATION HEREUNDER SHALL 
BE TO PERMIT USE OF THE SOFTWARE UNDER THE 
TERMS HEREOF. IN NO EVENT SHALL YAMAHA BE 
LIABLE TO YOU OR ANY OTHER PERSON FOR ANY 
DAMAGES, INCLUDING, WITHOUT LIMITATION, ANY 
DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, EXPENSES, LOST PROFITS, LOST DATA 
OR OTHER DAMAGES ARISING OUT OF THE USE, 
MISUSE OR INABILITY TO USE THE SOFTWARE, EVEN 
IF YAMAHA OR AN AUTHORIZED DEALER HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
In no event shall Yamaha’s total liability to you for all 
damages, losses and causes of action (whether in con-
tract, tort or otherwise) exceed the amount paid for the 
SOFTWARE.

7. GENERAL
This Agreement shall be interpreted according to and 
governed by Japanese law without reference to princi-
ples of conflict of laws. Any dispute or procedure shall 
be heard before the Tokyo District Court in Japan. If for 
any reason a court of competent jurisdiction finds any 
portion of this Agreement to be unenforceable, the 
remainder of this Agreement shall continue in full force 
and effect.

8. COMPLETE AGREEMENT
This Agreement constitutes the entire agreement 
between the parties with respect to use of the SOFT-
WARE and any accompanying written materials and 
supersedes all prior or contemporaneous understand-
ings or agreements, written or oral, regarding the sub-
ject matter of this Agreement. No amendment or revision 
of this Agreement will be binding unless in writing and 
signed by a fully authorized representative of Yamaha.
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For details of products, please contact your nearest Yamaha 
representative or the authorized distributor listed below.

Pour plus de détails sur les produits, veuillez-vous adresser à 
Yamaha ou au distributeur le plus proche de vous figurant dans 
la liste suivante.

Die Einzelheiten zu Produkten sind bei Ihrer unten aufgeführten 
Niederlassung und bei Yamaha Vertragshändlern in den jeweili-
gen Bestimmungsländern erhältlich.

Para detalles sobre productos, contacte su tienda Yamaha más 
cercana o el distribuidor autorizado que se lista debajo.
CANADA
Yamaha Canada Music Ltd.
135 Milner Avenue, Scarborough, Ontario,
M1S 3R1, Canada
Tel: 416-298-1311

U.S.A.
Yamaha Corporation of America 
6600 Orangethorpe Ave., Buena Park, Calif. 
90620, U.S.A.
Tel: 714-522-9011

MEXICO
Yamaha de México S.A. de C.V.
Calz. Javier Rojo Gómez #1149,
Col. Guadalupe del Moral
C.P. 09300, México, D.F., México
Tel: 55-5804-0600 

BRAZIL
Yamaha Musical do Brasil Ltda.
Rua Joaquim Floriano, 913 - 4' andar, Itaim 
Bibi, CEP 04534-013 Sao Paulo, SP. BRAZIL
Tel: 011-3704-1377

ARGENTINA
Yamaha Music Latin America, S.A. 
Sucursal de Argentina
Olga Cossettini 1553, Piso 4 Norte
Madero Este-C1107CEK
Buenos Aires, Argentina
Tel: 011-4119-7000

PANAMA AND OTHER LATIN 
AMERICAN COUNTRIES/
CARIBBEAN COUNTRIES 

Yamaha Music Latin America, S.A.
Torre Banco General, Piso 7, Urbanización 
Marbella, 
Calle 47 y Aquilino de la Guardia, 
Ciudad de Panamá, Panamá 
Tel: +507-269-5311

THE UNITED KINGDOM
Yamaha Music U.K. Ltd.
Sherbourne Drive, Tilbrook, Milton Keynes, 
MK7 8BL, England
Tel: 01908-366700

GERMANY
Yamaha Music Central Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, 
Germany
Tel: 04101-3030

SWITZERLAND/LIECHTENSTEIN
Yamaha Music Central Europe GmbH, 
Branch Switzerland
Seefeldstrasse 94, 8008 Zürich, Switzerland
Tel: 01-383 3990

AUSTRIA
Yamaha Music Central Europe GmbH, 
Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-60203900

CZECH REPUBLIC/SLOVAKIA/
HUNGARY/SLOVENIA

Yamaha Music Central Europe GmbH, 
Branch Austria, CEE Department
Schleiergasse 20, A-1100 Wien, Austria 
Tel: 01-602039025

POLAND
Yamaha Music Central Europe GmbH 
Sp.z. o.o. Oddzial w Polsce
ul. 17 Stycznia 56, PL-02-146 Warszawa, 
Poland
Tel: 022-868-07-57

THE NETHERLANDS/
BELGIUM/LUXEMBOURG

Yamaha Music Central Europe GmbH, 
Branch Benelux 
Clarissenhof 5-b, 4133 AB Vianen, The 
Netherlands 
Tel: 0347-358 040 

FRANCE
Yamaha Musique France 
BP 70-77312 Marne-la-Vallée Cedex 2, 
France
Tel: 01-64-61-4000

ITALY
Yamaha Musica Italia S.P.A. 
Combo Division
Viale Italia 88, 20020 Lainate (Milano), Italy 
Tel: 02-935-771

SPAIN/PORTUGAL
Yamaha Música Ibérica, S.A.
Ctra. de la Coruna km. 17, 200, 28230 
Las Rozas (Madrid), Spain
Tel: 91-639-8888

SWEDEN
Yamaha Scandinavia AB
J. A. Wettergrens Gata 1, Box 30053
S-400 43 Göteborg, Sweden
Tel: 031 89 34 00

DENMARK
YS Copenhagen Liaison Office
Generatorvej 6A, DK-2730 Herlev, Denmark
Tel: 44 92 49 00

NORWAY
Norsk filial av Yamaha Scandinavia AB 
Grini Næringspark 1, N-1345 Østerås, 
Norway 
Tel: 67 16 77 70

RUSSIA
Yamaha Music (Russia)
Office 4015, entrance 2, 21/5 Kuznetskii 
Most street, Moscow, 107996, Russia
Tel: 495 626 0660

OTHER EUROPEAN COUNTRIES
Yamaha Music Central Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, 
Germany
Tel: +49-4101-3030

Yamaha Corporation, 
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2313

TURKEY/CYPRUS
Yamaha Music Central Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, 
Germany
Tel: 04101-3030

OTHER COUNTRIES
Yamaha Music Gulf FZE
LOB 16-513, P.O.Box 17328, Jubel Ali, 
Dubai, United Arab Emirates
Tel: +971-4-881-5868

THE PEOPLE’S REPUBLIC OF 
CHINA

Yamaha Music & Electronics (China) 
Co.,Ltd.
25/F., United Plaza, 1468 Nanjing Road 
(West), Jingan, Shanghai, China
Tel: 021-6247-2211

INDONESIA
PT. Yamaha Music Indonesia (Distributor)
PT. Nusantik
Gedung Yamaha Music Center, Jalan Jend. 
Gatot Subroto Kav. 4, Jakarta 12930, Indonesia
Tel: 21-520-2577

KOREA
Yamaha Music Korea Ltd.
8F, 9F, Dongsung Bldg. 158-9 Samsung-
Dong,  Kangnam-Gu, Seoul, Korea
Tel: 080-004-0022

MALAYSIA
Yamaha Music Malaysia, Sdn., Bhd.
Lot 8, Jalan Perbandaran, 47301 Kelana 
Jaya, 
Petaling Jaya, Selangor, Malaysia
Tel: 3-78030900

SINGAPORE
Yamaha Music Asia Pte., Ltd.
#03-11 A-Z Building
140 Paya Lebor Road, Singapore 409015
Tel: 747-4374

TAIWAN
Yamaha KHS Music Co., Ltd. 
3F, #6, Sec.2, Nan Jing E. Rd. Taipei.
Taiwan 104, R.O.C.
Tel: 02-2511-8688

THAILAND
Siam Music Yamaha Co., Ltd.
891/1 Siam Motors Building, 15-16 floor
Rama 1 road, Wangmai, Pathumwan
Bangkok 10330, Thailand
Tel: 02-215-2626

OTHER ASIAN COUNTRIES 
Yamaha Corporation,
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2317

AUSTRALIA
Yamaha Music Australia Pty. Ltd.
Level 1, 99 Queensbridge Street, Southbank, 
Victoria 3006, Australia
Tel: 3-9693-5111

COUNTRIES AND TRUST 
TERRITORIES IN PACIFIC OCEAN

Yamaha Corporation,
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2313

NORTH AMERICA

CENTRAL & SOUTH AMERICA

EUROPE

AFRICA

MIDDLE EAST

ASIA

OCEANIA
HEAD OFFICE Yamaha Corporation, Pro Audio & Digital Musical Instrument Division
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, Japan 430-8650
Tel: +81-53-460-2441
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Yamaha Web Site (English only)
http://www.yamahasynth.com/

Yamaha Manual Library
http://www.yamaha.co.jp/manual/
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